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This Section is optional - if you have completed all of the
work to date and wish to know more, please work
through this section. Not completing this work will not
affect your final mark in any way, however it will add to
your understanding of Macros and will enable you to
tailor an Access database to a high degree.

Macros, More Forms & Menu
Systems

Aims of Session:
To enable you to:

Create, edit and run a simple macro
Design Forms using command buttons and option groups
Create a macro group
Name macros
Use macros with conditional statements
Use forms in conjunction with macros

Tailoring a complex system for ease of use
by Novice Users
By this point in the course you will be using Access in an in-
volved and sophisticated manner. However, you may be in the
position of being "the office expert" and you may wish to present
a much simpler interface to occasional and casual users. Al-
though the GUI (Graphical User Interface - in this case Win-
dows) helps greatly in enabling occasional users to use the
technology, there can be no doubt that a sophisticated database
package such as Access demands a great deal from the user;
indeed, think about the work that you've put in to reach this point
of the course.

How can we make things simpler for the occasional user?

We could provide some guided assistance, in particular we could
provide a menu of choices for the user. The drawback is that
there is a considerable lack of flexibility and the main advantage
is that there are few or no training requirements for the user.
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This section is concerned with enabling you to place yourself in the
position of being the "office expert" in a small organisation that
does not have a dedicated IT support department. The solutions we
shall explore are not to be thought of as computer programming but
do represent a step in that direction.

Creating a Simple Macro ("Hello World")
A macro is a way of automating tasks that are otherwise carried out
with the mouse or keyboard. A  macro can record a sequence of
key strokes and/or mouse actions, save them in a file (the macro)
and allow the user to play them back by simply running the macro.
This can save a lot of time in carrying out repetitive tasks. Macros
(at least in this particular package) can be made to respond to
events, such as the user clicking on a button or choosing a particu-
lar menu choice.

Whilst there are significant limitations  to the actions that can be
carried out with a macro, a high degree of automation can be
achieved without recourse to a programming language.  Indeed it
is possible to develop a complete database application using
nothing but macros.

Creating a Simple Macro
We are going to create a macro that does nothing but display a
message on the screen. "Hello World"  is the message that we
shall display and we'll call the macro "Hello".

Ensure that the student records database is open and that the

database window is on your screen.

Select  the MACRO tab (Figure 5.1).
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Figure 5.1: The Macro Tab

Click on the NEW button to display a Macro Window

(Figure 5.2)
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Figure 5.2: The Macro Window

Initially, the macro window has two columns, an ACTION column
and a COMMENTS column.  The ACTION column is where we
place the commands (or actions) that we want the macro to carry
out.

The COMMENTS column allows us to document the macros, i.e.
we can write in a meaningful description of what is going on.

There are many actions that can be carried out within  an Access
macro.  The basic actions that we are concerned with on this
course can be grouped into the following categories.

Open and Close database objects (Tables, queries,
forms and reports)

Display messages

Build menu systems

Export/Import data to/from other applications
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The MSGBOX action
The MSGBOX action enables us to display a message on the
screen . We'll use this to display the message "Hello World".

Ensure that the ACTION

column of the first row of the
Macro Window is selected and
click on the "down arrow" icon.

This will result in a list of actions
(Figure 5.3).

Figure 5.3: Macro action list

Scroll down until the MSGBOX

action appears.

Select the MSGBOX action by

clicking on it

Figure 5.4: Selecting the MSGBOX action

Move to the comments column and type in the phrase "say

hello world".

This will remind us at a later date what the macro is doing.

We've told the macro that we want to display a message, how do
we tell the macro what the message is and how to display it?

We need to supply the action arguments.

Arguments are the items of data that the action needs to com-
plete its work. In this case a necessary argument would be the
text of the message that we want to display. Other arguments
exist for this action and will be considered as we work through
the example.
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Figure 5.5: MSGBOX arguments

Figure 5.5 shows the arguments that the msgbox action expects.
They are:

Message: the text of the message

Beep: YES or NO depending on whether you want a
beeping sound when the message is displayed

Type: Tells Windows to display the message as
Critical, Warning!, Warning? and Information.
None is also an option.

Title: This is the text that is displayed in the MSGBOX
title bar.

Enter the text "Hello World"  in the Message box

Select Yes in the Beep box

Select Information in the Type box
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Enter the text "First Macro" in the Title box

The completed arguments are shown in  Figure 5.6.

Figure 5.6: Completed Arguments for the "Hello World" macro

Save the macro by selecting the FILE/SAVE option

When prompted, save the macro as "Hello"

Test the macro by running it - do this by clicking on the

run button in the toolbar.

If the Microsoft Office Assist-
ant is not running,  you should
see Figure 5.7 on your screen.
Alternatively you will see the
message displayed via the
Assistant as shown in
Figure 5.8.

Figure 5.7: Hello World (No Office Assistant)

Figure 5.8: Hello World (With Office Assistant)
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When you are satisfied that your macro works, close the

macro window to return to the Database window.

Try running the "Hello" macro directly from the database

window either by double clicking on it or by selecting it
(highlighting it) and then pressing the RUN button.
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Building our own menu system using forms
and macros
The work we did  in the last section on forms and switchboards can
be developed. Although the SwitchBoard was a good start such
techniques are limited in their scope. Building a meneu system
using macros is a more configureable way of approaching the task.
Macros are effectively scripts that allow us to control the behaviour
of  Access. Macros stop short of programming althoough they do
offer some of the control and flexibility that programming gives us.

The Northern College Student Record System
(Ver 2)
Consider  Figure 5.9.  The menu system consists of three forms
and they are linked together by macros that are activated by click-
ing on COMMAND BUTTONS. Each of the forms has on it the
following objects:

Command Button

Option Group (comprising of option buttons and labels). An
options group is used to display a set of  option
buttons. Only one of these buttons can be
selected at anyone time, and it is possible for a
macro to know which button is selected. In
programming terms an option group would be
known as an array.
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Figure 5.9: Student Records Menu System using individually
designed forms and macros
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Creating the Main Menu Form
Much of the work done in the last section is applicable here. As the
forms are similar, we are going to create one and make two cop-
ies. We will amend the copies as needed. Each form has two
command buttons (OK and Cancel) and an options group.

Ensure that the database window is open and that the

FORMS tab is selected

Click on the new button to begin creating a new form

This time we won't use a wizard.

Select the DESIGN VIEW option

We are not basing this form on a table or query so do not select
a table or query, simply

press the OK button.

This will take you straight to the form design view ( Figure 5.10).

Figure 5.10: Creating a form for our menu system

Make the grid area a little larger by dragging the bottom

right corner.

From the toolbox, select the OPTION GROUP object
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Drag an outline of the option group over the form grid.

Make it large enough to cover the left half of the grid.

If you are uncertain, have a look at the forms in Figure 5.9. Don't
worry about the exact size and positioning at this stage.

An option group wizard will open (Figure 5.11).

Enter the options needed for the main menu.

They are:
Reports
View Data on Screen
Export data to Excel.

Note: The process of adding this data is similar to the process of
adding a student record in STUDREC.

Figure 5.11: The Options Group Wizard

When you've finished your screen should look like Figure 5.12.
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Figure 5.12: Main Menu Choices

Click on the NEXT button

You will now be prompted to select a default option.

Select "No, I don't want a default"

Click on the NEXT button

The wizard now assigns values to each choice (they'll be 1,2 and
3 in this case). Although you can change these values we won't
do so in this example. The values are numbers that a macro can
refer to in order to find out which choice the user has selected,
so if the macro finds 1, it "knows" that the user has selected the
REPORTS option.

Press the NEXT button to move to the "style" window of the

wizard (Figure 5.13)
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Figure 5.13: Choosing an Options Group Style

Select "Option Buttons" and "Etched" - BUT please play

around with the settings and observe the effects in the left of
the window.

Press the NEXT button

Type in the caption "Select an option" for the frame group

Press the FINISH button

The form will look like Figure 5.14. The option group can be
selected and moved and resized just like any other object - it IS an
object.
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Figure 5.14: Option Group on a Form

Now we need to add two COMMAND BUTTONS, one for OK and
the other for CANCEL

Select the Command button icon from the toolbox

In the top right quarter of the form design grid, drag the

mouse to create a command button (this one's going to be the
OK button)

Don’t worry about the exact size and position of the button at this
stage, you can always adjust things later. Drawing the command
button object on the form will activate the Command Button
Wizard (Figure 5.15).
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 Figure 5.15: The Command Button Wizard

This wizard enables us to assign actions to the button (such as
Go to the Last record in a data table or query). An action is what
happens when the button is clicked on.

Select the MISCELLANEOUS category (the list of available

actions will change)

Select the RUN MACRO option (we're doing this because we

are constructing a menu system out of forms and macros).

Press the NEXT button (you should now see a list of avail

able macros - it will be a short list; it will contain one
macro called HELLO because that's all we've written so
far).

Select the HELLO macro (we will change it later)

Press the NEXT button to move to the text/picture definition

window (Figure  5.16)
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Figure 5.16: Formatting a Command Button

As this is the OK button, select the TEXT option and type

in the text "OK" (no quotation marks)

Press the NEXT button

Rename the Command Button to "OK Button"

Press the FINISH button

If you need to, move and resize the OK button

So far, we've created a form that has on it an options group and
a command button. We now need to place a second command
button on the form (underneath the OK button) that will allow us
to close the form. The button will be a CANCEL button.

Select the COMMAND BUTTON icon from the toolbox

Draw the outline of the second command button on the form

(make it roughly the same size as the OK button that you've
just created, and place it underneath the OK button). This
will activate the Command Button wizard (Figure 5.17).
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Select TEXT and type in the text "CANCEL"

Press the NEXT button

Rename the command button to "CANCEL BUTTON"

Press the FINISH button

Save the form as "STUDENT RECORDS MAIN MENU"

View the form in FORM VIEW (you should see something

like Figure 5.19)

Figure 5.18: Setting Actions for the CANCEL button

Select the FORM OPERATIONS category

Select the CLOSE FORM action (the close form action

closes the current form)

Press the NEXT button to move to the text/picture definition

window
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Figure 5.21: Choosing "Form Properties"

Figure 5.19: Main Menu (ver. 1)

This form is good for a first attempt, but it could do with cleaning
up a bit. The most obvious thing wrong here is that there is a
record navigation bar at the bottom of the form. This would be
fine if the form was designed to enable us to scroll through a set
of records, but that's not the case here.

Switch to design view

Click on the "object properties button" with

the rightrightrightrightright button of the mouse, i.e. the
square in the top right corner of the form
(see Figure 5.20).

Figure 5.20: Selecting "Form properties Menu Button"

The following menu should
appear (Figure 5.21)
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Select the PROPERTIES option. Note that these properties

belong to the form as a whole and not to the individual
objects on the form.

You will see the following properties window (Figure 5.22).

Figure 5.22: Form Properties

This form allows us to define exactly how the form will behave.
The following properties are worthy of comment at this stage.

Caption This is what will appear in the title bar of
the form

Enter “The Northern College SRS”

Default View Determines whether the form will be
displayed as a datasheet, a continuous
form or a single form

Enter  SINGLE FORM

Views Allowed Determines whether the user can switch to
design view

 Select FORM

Scroll Bars Do we want scroll bars

Select NO
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Record Selectors These are the buttons that move to the next
record or back to the last record

Select NO

Navigation Buttons These are the "Fast Forward to end of file
&  Rewind to Beginning of file buttons (we
don't want to show them)

Select NO

Dividing lines Do we want dividing lines drawn across our
form?

Select NO

Auto Resize If yes the form will be resized to fit a record
in it - this is not applicable in this case

Select NO

Auto Centre Actually, it's "Center" but that's an American
spelling, Yes to automatically centre the
form on the screen.

Select NO

Border Style What sort of border do we want around the
form

Select SIZABLE

Control Box Do we want the user to be able to access a
pull down menu by clicking in the left corner
of the title bar?

Select YES

Min Max Properties Can the user see the Minimise and
Maximise buttons

Select NO
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Close Button Can the user close the form with the
CLOSE button?

Select YES

Ensure that your form properties are set to those shown in
Figure 5.22.

Save your form (as Student Records Main Menu)

Close the form

Copying the Main Menu Form to create two Sub
Menu forms

It would be quite a major task to create our two sub menu forms
from scratch, however, we don't need  to. We can simply make
two copies of the "Main Menu" form and amend them to suit.

The following procedure will take you through creating the
REPORTS sub menu. You will be expected to create the
VIEW menu on your own.

Select the STUDENT RECORDS MAIN MENU FORM and

make a copy of it (select copy from the EDIT menu)

PASTE the copy of the form back into the forms section of

the database window

When prompted, rename the copy as REPORTS MENU

Select the REPORTS MENU

Switch to design view
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Figure 5.23: Selecting the PROPERTIES option

If the “form properties” window is not open right click on

the "form properties" button to call up the form
properties menu

Select the PROPERTIES menu option

Change the CAPTION property from "The Northern College

SRS" to "Reports Menu" (don't type the quotation marks).

Close the form property box

We now have to change the text in the Options Group header
from "Select an Option" to "Available Reports".

Right click on the Options Group header to call up a menu

for that object (Figure 5.23)

Select the PROPERTIES option to display the label

properties window (Figure 5.24)
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Figure 5.24: The CAPTION property

We now need to change the labels for each of the three options
in the options group in the same way. The following instructions
take you through this process.

Right click on the option 1 label (Reports)

Select the PROPERTIES option from the pop up menu

Change the CAPTION  property (under the Format tab)

from "Reports" to "AllStudents by Name" (Resize the label if
you need to)

Close the Properties box

We'll do this again for the second option.

Right click on the option 2 label (View Data on Screen)

Select the PROPERTIES option from the pop up menu

Change the CAPTION  property (under the Format tab)

from "View Data on Screen" to "All Students from Barnsley"
(Resize the label if you need to)

Close the Properties box

Edit the caption property to read "Available Reports"

(Figure 5.24)

Close the properties box
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And once more for the third option.

Right click on the option 3 label (Export Data to Excel)

Select the PROPERTIES option from the pop up menu

Change the CAPTION  property (under the Format tab)

from "Export Data to Excel" to "Gender Analysis of all
Students"  (Resize the label if you need to)

Close the Properties box

Check your form & make sure that you're happy with it

Save the form

Exercise 5: Question 1.
Edit the form "View Menu" so that it looks like the one shown
in Figure 5.25. Be sure to save the form as "VIEW MENU".
Assessment will consist of showing your tutor the form on your
computer screen.

Figure 5.25: The View Menu
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Macro Groups
There are now three forms, each of which is part of a menu system
for our student records system. We  have to make them work in
conjunction with each other. This requires a macro to be written for
each action (calling a sub menu, running a report, closing a form
etc.).

There is a potential problem here. We could easily find ourselves
writing a great number of macros and it would quickly become
difficult and unwieldy to keep track of them all.  The answer to
this problem is to make use of Macro Groups. A Macro Group
can be used to group together all those macros that have some-
thing in common.  In the worked example that follows,  we are
going to group together all those macros that have a role to play
in the menu system.

Select the Macro tab in the Database Window

Click on the NEW button

As with the previous "Hello World" macro, we have an Action
Column and a comments column. However, we need to add in a
NAMES column (so we can give our macro(s) a name(s)) and a
conditions column (so we can conditionally execute a macro).
Conditionally executing a macro means that we only wish to
execute a macro if some testable condition is true, e.g. execute
the macro to run the Gender Analysis report, only if that's what
the user chose from the menu.

Locate the MACRO NAME button in the toolbar and click

on it.

This will add a further column (Macro Name) to the Macro design
sheet.

Locate the CONDITIONS button in the toolbar and click on

it.

This will add another column (Conditions) to the Macro Design
sheet.
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We are going to set up a series of macros that work with the "Main
Menu" form and with the "Reports Menu" form. We'll leave the
"View Menu" for the moment as you will be asked to work through
that on your own.

The "Quit from Main Menu" macro
We need to give this macro a name, we'll call it "quitmain".

In the first row of the macro design window, in the column

MACRO NAME, type "quitmain"  (don't type the quotation
marks)

We want this macro to run every time we click on the QUIT but-
ton in the main menu form, therefore
there are no conditions to satisfy - the macro will run each and
every time we click on the QUIT button.

Skip the CONDITIONS column and under the ACTIONS

column, select the action CLOSE

In the bottom left of your screen you will be asked to define the
object type that you want to close (i.e. whether it's a table, query,
report etc.), the name of the object that you wish to close and
whether you wish to save the object when you close it.  in this case
the object type is a FORM,  the name of the form is STUDENT
RECORDS MAIN MENU, and we do not need to save it.

Under OBJECT TYPE, select FORM

The form name is STUDENT RECORDS MAIN MENU

NO, we won't save the form when we close it
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Figure 5.26: The QUITMAIN macro

Close the Macro Design Window, when prompted save the

macro as MENUSYSTEM

Now we need to edit the properties of the QUIT button in the
STUDENT RECORDS MAIN MENU form to indicate that when
the user clicks on it (the QUIT button), the QUITMAIN macro
should be run.

Open the STUDENT RECORDS MAIN MENU form

Select design mode

Right click on the CANCEL button

Select the PROPERTIES option from the pop up menu
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Figure 5.27: ON CLICK event

Close the PROPERTIES box

Switch to FORM VIEW

Test your macro by clicking on the CANCEL button (the

main menu form should close)

Configuring the Ok Button on the main menu form
At the moment, pressing the OK button on the main menu will
run the "hello world" macro, we assigned the “Hello World”
macro to this button in an earlier exercise. Whilst this is fine for a
first exercise, it won't do for a working menu system. We need to
replace it with a macro specially designed to carry out one of the
three choices available to us.  We'll develop this macro by
editing the MENUSYSTEM macro (which is really a macro group
because it has one or more named macros within it (so far we've
got one macro in it called quitmain; we refer to it as
menusystem.quitmain).

The macro we are going to develop depends upon us knowing
what the name of the options group frame is in the STUDENT
RECORDS MAIN MENU. We need to ensure that the frame
name is "menu".

Open the Student Records Main Menu

Ensure that you are in design mode

Select the EVENT tab in the CANCEL BUTTON properties

box

Select the macro "menusystem.quitmain"  in the event box

for ON CLICK (Figure 5.27)
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Right click exactly on the etched border of the options group

Select the PROPERTIES option from the pop up menu

Select the OTHER tag of the properties box

Change the NAME property from whatever it is (probably

Frame0 or similar) to menu (Figure 103)

Close the properties box

Close the form and confirm that you want to save the

changes you have just made

Figure 103: Changing the name of the options group

Open the MENUSYSTEM macro in design mode
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Remember that when we created the three options in the options
group, each of them had a number associated with them, i.e. 1, 2
& 3 respectively. We can test to see if the number selected is 1,
2 or 3.
The conditions we are going to include in the macro are:

Forms![Student Records Main Menu]![menu]=1
Forms![Student Records Main Menu]![menu]=2
Forms![Student Records Main Menu]![menu]=3

Each test can be explained as follows:

Forms what type of object are we
referring to (a form in this case)

! this is used to "join together" the
various bits of the testable
condition

[Student Records Main Menu] this is the name of the object

! we're joining another bit on

[menu] which control object on the form?
(called menu in this case)

=1 or 2 or 3 have we selected choice 1, 2 or
3

Ensure that you enter the macro (called MAINCHOICE) as

shown in Figure 5.28

Figure 5.28: Building the MAINCHOICE macro (1)

Any macro will execute each statement in turn until a blank line
is encountered so make sure that you do leave a blank line
between each macro.
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At present we've got three lines in our  “mainchoice” macro. Only
one of these lines will be executed depending on which options
button the user has selected before pressing the OK button.  The
“mainchoice” macro has to perform three tasks:

1 open a form for the reports sub menu
2 open a form for the VIEW sub menu
3 export the data in the table STUDREC into  an Excel

spreadsheet  (an optional task, just so you can see
that it can be done)

Move to the action cell in the first line of the mainchoice

macro

Select the OPEN FORM action

We need to supply additional information to this action (the addi-
tional information is supplied as "arguments"). This is done in the
bottom left of the screen (Figure  5.29)

Figure 5.29: mainchoice macro (open form action)
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Type in the FORM NAME "Reports Menu" (no quotation

marks)

Set the VIEW option to FORM

Set the DATA MODE option to EDIT (we want to be able

to select a choice)

Set the WINDOW MODE to NORMAL

Close the macro design window and save the changes when

prompted

In order to test what we've done so far, we need to assign this
macro (the mainchoice macro) to the “OK” button on the main
menu form.

Open the STUDENT RECORDS MAIN MENU form

Ensure that you are in design view

Right click on the OK button

Select the PROPERTIES option from the pop up menu

Select the EVENT tag in the properties window

Set the On Click event to the macro menusystem.mainchoice

(Figure 5.30)
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Figure 5.30: Assigning the mainchoice macro to the OK button

Close the properties window

Switch to FORM VIEW

Select choice 1 (Reports Menu)  This should open the Re

ports sub menu, don't proceed until it works.

Close the reports window

Close the Main Menu

We need a macro to quit from the REPORTS MENU when the
user clicks on the “CANCEL”  button of the REPORTS MENU
form.

Open the menusystem macro in design mode

Leave a blank line underneath the mainchoice macro and

type the name"quitreports" (no quotation marks)  in the
Name column

Move to the action column of the same line and select the

CLOSE action

We need to supply the arguments for the CLOSE action

Under OBJECT TYPE, select FORM
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The form name is REPORTS MENU

NO, we won't save the form when we close it

Close the Macro Design Window (save the changes)

Test the macro by:

Opening the STUDENT RECORDS MAIN MENU form

Selecting the “Reports” option

Clicking on the OK button

The “Reports” Menu should be displayed.

Click on the Cancel button of the Reports menu

This will run the quitreports macro and close the form. You
should be able to repeat this sequence at will.
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Close all forms

Configuring the Reports Menu form

Let's take the menu system further by plugging in the routines
that will make the “REPORTS MENU” form work.  We will need
to write a macro to test which choice the user has made and to
display or print the appropriate report.

We'll call our macro “REPORTCHOICES”; to create it we'll need
to open the MENUSYSTEM macro group. Take care to name the
options group object "menu" (as we did for the main menu)

First we'll make sure that the option group is called "menu"

Open the REPORTS MENU form

Ensure that you are in design view

Right Click on the Options Group object (click on the etched

border)

Select the PROPERTIES option from the pop up menu

Select the OTHER tag of the properties box

Change the NAME property to "menu" (no quotation marks)

Close the properties box

Close the REPORTS MENU FORM (save the changes)

Now we'll create the “reportchoices” macro

Open the MENUSYSTEM macro group in design mode

Locate the quitreports macro
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Figure 5.31 recordchoices conditions

We now need to assign an action to each line. We know we want
to run a report for each choice so we'll select the OPEN RE-
PORT action in each case.

NOTE:  if we wanted to open a query, we would select the OPEN
QUERY action, this will be needed when you are developing the
VIEW sub menu.

Move to the action cell in the first line of the recordchoices

macro

Select the OPEN REPORT action

We now have to define what the report is called, whether we
wish to print it or merely display it on screen and whether there
are any filters involved. These arguments are supplied in the
bottom left of the screen.

Leave a blank row underneath the quitreports macro

In the Name column, type "reportchoices"  (no quotation

marks)

Type in the three conditions as shown in Figure 5.31
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Enter the name of the report (All Students - by name)

Select PRINT PREVIEW as the view option

We have just defined what happens if the user selects option 1
on the main menu form. Let's proceed and complete the code for
choices 2 and 3.

Move to the action cell in the second line of the

recordchoices macro

Select the OPEN REPORT action

Supply the action arguments as follows:

Report Name = Barnsley

View = PRINT PREVIEW

Move to the action cell in the third line of the recordchoices

macro

Select the OPEN REPORT action

Supply the action arguments as follows:

Report Name = Gender Analysis

View = PRINT PREVIEW

Close the macro window and save the changes you have made

We have now written the second macro in the group and we
must now assign this macro to the OK button in the Reports
Menu form.
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Open the REPORT MENU form

Ensure that you are in design mode

Right click on the OK button

Select the PROPRTIES option from the pop up menu

Select the EVENT tag of the properties box

Enter the macro name "menusystem.reportchoices" in the On

Click property box (no quotation marks)

Close the Command Button properties box

Close the REPORTS MENU form (save the changes)

We're now ready to test the menu system that we have developed
so far. The menu system will load a main menu, select a reports
sub menu, and select three reports from that sub menu.

Load the STUDENT RECORDS MAIN MENU form

Ensure that you are in FORM view

Select the REPORTS option and click on the OK button

This should display the REPORTS sub menu

Select option 1 (list all students). This should open the

report in a print preview window on your screen.

Close the report

Select each report in turn, ensuring that it all works.

Close all the forms
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Exercise 5:  Question 2.

Refer to Figure 5.9. Ensure that you devise the appropriate
macros to include the VIEW MENU form options in your menu
system.  Your macros should be stored in the  menusystem
macro group.

You should enable a user to execute all choices in both sub
menus. Each sub menu should be capable of being closed by
clicking on the CANCEL button.

This question will be assessed by showing the working system
to your tutor.

Exercise 5 - Optional Extra
If you have the time and the inclination, you might like to
consider how you could make the third choice on the main
menu work, i.e. how could you export data from the STUDREC
table to an EXCEL spreadsheet file.

You don't HAVE  to do this but if anyone does rise to the
challenge, I'm prepared to be impressed!


